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1. Scope of delivery

Before starting the installation, please check the product delivered for completeness. The running capabili-
ty of all OPEN MIND products can be ensured only if the following requirements are in place:

• Compatible hardware and software

• Installed dongle driver

• Plugged-in dongle with activated products

• Installed software

Content of the product data media Software copy protection Licensing

Installa-
tion

Installation
instruc-
tions

Software
docu-
mentation

Computer
ID

Dongle (lo-
cal / serv-
er)

Activation
code

Li-
cence

hyperMILL®

for hy-
perCAD®-S

x x x - x x
-

hyperMILL®

for Auto-
desk® Inven-
tor®

x x x - x x

-

hyperMILL®

for SOLID-
WORKS

x x x - x x
-

hyperMILL®

SHOP View-
er

x x x - x x
-

CAD interfa-
ces x x x - x x -

Post Pro-
cessors - - x - x x -

The activation code is supplied by e-mail.
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2. Content of the product data media

• Installation of the CAM program hyperMILL® (including Toolpath Editor, hyperVIEW, OPEN MIND
tool database) with hyperCAD®-S or hyperMILL® SHOP Viewer as optional components.

• OPEN MIND license manager and codemeter dongle driver (local, server) in hyperMILL® installation
integrated.

• Installation instructions.

• Software documentation: Documentation is included on the product data media

Postprocessors are provided in a customer-specific manner.
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3. Installing and configuring

Requirements for ensuring a smooth hyperMILL® installation

Windows 10 and Windows 11

1. Your hard drive should have at least 7 GB of free storage space.

2. Is your operating system and CAD platform supported by hyperMILL®? Please check this in the
release notes in the Supported software section.

3. Log in as a local administrator.

4. Stop the scanning process of your antivirus software.

OPEN MIND also recommends excluding the following directories, file types, processes and services from
the virus scan:

Directories

NC file Specified by the user

Post processor Specified by the user

CAD file Specified by the user

hyperMILL installation Default path: C:\Programs\OPEN MIND\

General workspace hyperMILL® settings -> Application -> Default paths

Project hyperMILL® settings -> Document -> Directories

Licensing software C:\Program Files (x86)\CodeMeter

OPEN MIND Roaming C:\Users\User Name\AppData\Roaming\OPEN MIND

OPEN MIND temp C:\Users\User Name\AppData\Local\Temp\OPEN MIND

OM ProgramData C:\ProgramData\OPEN MIND

File types

*.3df *.nc *.ovz *.tmpof

*.comp *.nclist *.pcf *.tool

*.def *.ncmap *.pof *.vis
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File types

*.h *.oma *.ppcfg *.vmm

*.hmc *.omx *.pprpt *.vnc

*.hmrep *.omgcfg *.settings

*.hvz *.origin *.so

These file types are trusted as they are generated exclusively by hyperMILL®.

Processes

CodeMeter.exe GetHS.exe omCheck_x64.exe

cycrunx64.exe hmc.exe omHV.exe

LicenseManager.exe omHV64.exe

omToolDBW32.exe

omToolDBX64.exe

Services

Service of CodeMeter.exe

Please have your IT set the antivirus software according to these specifications.
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Overview of the installation process
The installation is always local.

For the CAD-integrated products hyperMILL® for Autodesk® Inventor® and hyperMILL® for SOLIDWORKS,
a working version of the respective CAD software must have been installed and already started once.

The installation requires administrator rights.

1. The installation starts automatically. Follow the installation instructions.

2. In the second step, configure the software that has been installed using the hyperMILL®CONFIG-
URATION Center. For more information, see section hyperMILL®CONFIGURATION Center.

Installing OPEN MIND software
Install the hyperMILL®, hyperCAD®-S, hyperMILL® SHOP Viewer and the License Manager programs:

1. Start installation: Call the installation under Products.

2. Select language for the installation: Select the language for the installation.

3. Licence agreement: Read and accept the terms and conditions of the license agreement and click
Next.

4. Select target folder: Click Next to confirm the directory in which the components are to be instal-
led. You will be shown a default path (C:\Program files\OPENMIND) that you can change
using the Change button.

5. Select and install programs: Select the programs to be installed.

The OPEN MIND licence manager must always be installed, however, it can also be installed separately
for use as a licence server, for example.

We regularly update our licence management software with the latest security updates
and new functionality. The components required for licensing must therefore always be
kept up to date, including on the licence server. Check regularly whether your licence
management is still up to date.

A simultaneous installation of hyperMILL® / hyperCAD®-S and hyperMILL® SHOP View-
er is not possible. At the time of installation, you can choose whether to use your
computer as a CAD/CAM work station or as a hyperMILL® SHOP Viewer work station.
Subsequent selection is possible in the licence manager.

Apply settings from previous version
During the installation, the hyperMILL®CONFIGURATION Center is started automatically and a check is
performed to see whether another version of hyperMILL® has already been installed on the PC. If this is
the case, you can apply the settings of this version. To do this, activate the function:

Apply settings from previous version.
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This function must be activated by each user who wants to transfer the personal settings of a previous
version.

During installation, define the following basic settings in the hyperMILL®CONFIGURATION Center dia-
logue.

You can also apply the settings from an earlier version later at any time using the
hyperMILL®CONFIGURATION Center. Likewise, you can change the basic settings
later with the hyperMILL®CONFIGURATION Center. To start the hyperMILL®CONFIGU-
RATION Center manually, go to the Windows Start menu:

hyperMILL® [version] → hyperMILL®CONFIGURATION Center.

For more information on configuring the software, see section Configuring the OPEN
MIND software (page 10).

hyperMILL® system settings
Global working space: Specify where the files generated by hyperMILL® are to be saved. By default, the
location is

C:\Users\Public\Documents\OPEN MIND.

MDF path: Directory for saving the machine definition files. By default, the location is

C:\Users\Public\Documents\OPEN MIND\mdf.

Project paths: If you work with project directories, the data generated will be stored here. By default, the
location is

C:\Users\Public\Documents\OPEN MIND\Projects.

To change the default directory, use the Change button and select the required directory.

Use project paths: The files generated by hyperMILL® are saved at the previously specified Project path.

Language: Set the language for hyperMILL®.

Measurement system: Specify the measurement system ( Metric/Inch) for hyperMILL®.

CAD platform: The platforms identified during the installation are displayed. Select the required CAD
platform(s). Then click Next. The Setup application database project dialogue opens.

Setup application database project
In this dialogue, you create the databases according to your requirements. The following functions are
available:

Import databases from an earlier version: This creates a database project on the basis of an application
tool database and application macro database from an earlier version of hyperMILL®.

Empty database project: This creates a database project with an empty tool and/or macro database.

Demo database project: This creates a database project using the available demo databases, see:

<Installation directory>/Tool Database/<version>/template database/<language>/
demo.db.

Please note that the demo data in these tool databases is provided to illustrate the vari-
ous functions and is not intended for production purposes. OPEN MIND disclaims any
liability for damages resulting from the use of demo data in a production environment.
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New database project: This creates a database project on the basis of any existing databases in the .mdb
and .db formats.

You can combine databases from different areas. For example, you can combine an empty macro data-
base and a tool database from an earlier version of hyperMILL® into one database project. You can
change the name of the database project as you wish. Click Next when you have completed all the
settings.

You can change the database directories later at any time in the hyperMILL® Settings.
Start the dialogue via the hyperCAD®-S menu hyperMILL® → Setup → Settings → Data-
base.

You will be informed that the settings have been applied. The installation and initial configuration of
hyperMILL® are complete. Click Close to close the dialogue.

Configuring the OPEN MIND software
The hyperMILL®CONFIGURATION Center starts automatically after an installation has been carried out.
To start the hyperMILL®CONFIGURATION Center manually, go to the Windows Start menu: hyperMILL®

[version] → hyperMILL®CONFIGURATION Center.

The user interface is divided into the following functional areas.

Set basic settings
If required, you can subsequently adapt the basic settings that you defined during the installation here, see
hyperMILL® system settings (page 9).

Apply user settings from previous versions
Must be executed by every hyperMILL®user who wants to apply their personal settings from a previous
version.

Connect applications
Click the Connect applications entry to start the OPEN MIND Application Settings dialogue. The following
functions are available:

Area of application
For: Shows the area of application for the application settings.

<System>: The settings apply to all users of the system. They can only be changed when the hy-
perMILL®CONFIGURATION Center is run as administrator.

[User name]: The settings apply to the current user.

Language
Shows all languages registered for this program version. Selecting the relevant language switches the
language for hyperMILL and auxiliary programs ( hyperVIEW, OPEN MIND Tool Database etc.), but the
hyperCAD-S setting remains unchanged.

[Language]: Displays the language set for the current user.

[Language] <System>: Shows the language set for all users of the system. After this option is selected, the
active user returns to using the currently active system language. When the system language is changed,
the language is also changed again for this user.

Registered applications
List of registered applications.

Programs registered for all users are displayed in gray. Unless the Application Settings program is started
with administrator privileges, it will not be possible to edit or delete these entries.
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Programs that are registered for the currently active user are displayed in black and can be edited and/or
deleted by the currently active user.

New: Add new application to the applications list.

Edit / Delete: Edit or remove the existing application from list of registered applications.

Key: Name used by OPEN MIND programs to start the application or function.

Name: User-defined application name.

Program: Complete path name under which the application is installed.

Arguments: Users can enter additional parameters.

Export and import settings
You can use the hyperMILL®CONFIGURATION Center to transfer data and settings from one PC to
another. This may be necessary

1. if a PC was replaced or

2. hyperMILL® and hyperCAD®-S should have the same settings on several PCs.

Export settings
Proceed as follows to export data and settings:

1. Click the Export Settings entry to open the Export Requirements dialogue page. This dialogue
asks you to close all OPEN MIND applications. Please note that you must be logged in with the
same Windows user account with which you also use hyperMILL®. Click Next.

2. The export directory is displayed on this dialogue page. To change the default directory, use the
Change button. If an export file (default = mySettings.omSettings) with the same name has
already been created in the selected directory, it will be overwritten when exporting if you activate
the Overwrite existing export file? function. Click Next.

3. The next dialogue page shows an overview of the exported data and settings in the hyperMILL®

Directories, Admin Settings, Databases, Postprocessors and Licence sections. Click Next to start
the export.

4. Close the dialogue once the export has finished.

Import settings
Proceed as follows to import data and settings:

1. Click the Import Settings entry to open the Import Requirements dialogue page. This dialogue
asks you to close all OPEN MIND applications. Please note that you must be logged in with the
same Windows user account with which you also use hyperMILL®. In addition, the user account
requires administrator rights during the import. Click Next.

2. On the Import Settings dialogue page, click Select omSettings file and select the previously
exported *.omSettings file. Then click Next.

3. The next dialogue page shows an overview of the data and settings to be imported in the
hyperMILL® Directories, Admin Settings, Databases, Postprocessors and Licence sections. Click
Next to start the import.

4. If data with the same name are already present on the target PC, you will be informed of the
import details on the last dialogue page . Click Close to close the dialogue.
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How does data export/import take place?

• Before the import process, all settings and data are stored in a backup file in the following directory:
C:\Users\Public\Documents\OPEN MIND\backup\backup.omSettings.

• Existing data with the same name on the target PC will not be overwritten during the import process.
The data will either be saved as a copy (example: databases) or the import will not take place at all
(example: postprocessors). Information on the import will be summarised (each section separately)
in a text file and saved in the following directory:
C:\Users\Public\Documents\OPEN MIND\tmp\Settings Wizard.

• Local, network and mixed environments are supported.

• Missing directories are created.

• No user decisions are required.

Perform a system check
Click the Check System entry to start the System check tool in order to check whether the PC is suitable
for hyperMILL®.

System check tool

Determine and evaluate system information.

Help → System check tool

Determine system information that could prevent stable operation, evaluate with regard to hyperCAD®-S
and gather the information to send to OPEN MIND support. For this purpose, the separate software
systemtoolcheck.exe can also be called in the root directory of hyperCAD®-S.

System information and test results
The software checks, for example, the operating system, CPU type, graphics card as well as the display
driver, graphics settings, current resolution and the OpenGL settings (content and version). Exactly the
same settings as required for hyperCAD®-S are used here.

The information that is found is compared to the system requirements set by OPEN MIND, evaluated and
listed in a clear summary under Check and in a detailed report under Details.

Check

Displays a summary overview of the test results for the user. The evaluation provides the following results:

The analysis is still running or is not possible.

Error Tested attributes need to be changed. The software cannot function properly.

Warn-
ing

Tested attributes need to be checked again. It may be possible to optimise a
attribute, for example, if a non-tested display driver is found.

Info Tested attributes are correct.
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Details

Displays a detailed report of all tested attributes with the test results to be evaluated by OPEN MIND
support. The detailed evaluation provides the following results:

Error Tested attribute needs to be changed. The software cannot function properly.
Errors are coloured red.

Warn-
ing

Tested attribute needs to be checked again. It may be possible to optimise
the attribute, for example, if a non-tested display driver is found. Warnings are
coloured orange.

Info Tested attribute is correct. Info is coloured green.

- Attrib-
utes

Determined software and hardware attributes, plus further information and mes-
sages.

Right-click to open a context menu with the following commands:

Table 1. Commands on the context menu:

Command Explanation

Copy Copy the selected text to the clipboard.

Copy link ad-
dress

Copy link address to the clipboard. To do this, right-click the link beforehand.

Select all Select all text.

Tips
Tips on dealing with the warnings and errors from the results of the test. Check whether the compatibility
required to use the OPEN MIND software can be established by implementing obvious measures:

Operating system The supported operating systems can be found in the installation guide
for OPEN MIND products. Information is also provided on the OPEN
MIND website under Useful information. Use a computer with an oper-
ating system that is supported.

Desktop composition Configure the operating system so that it complies with the recommen-
dations for the graphics card and monitor. Also see Graphics card and
monitor.

Free space on system disk There must be enough storage space on the hard disk for storing
temporary data (according to the size of the CAD/CAM data that is
processed). Clean up the hard disk so that there is enough free storage
space to allow the software to operate safely, swiftly and smoothly.

Total memory (RAM) A large total memory (RAM) is recommended to ensure that the OPEN
MIND software runs safely, swiftly and smoothly. Information is also
provided on the OPEN MIND website under Useful information. Check
whether the computer’s total memory can be increased.

Free memory (RAM) Close other software programs that are not required, for example, dis-
able any start-up software programs that run automatically when the
computer starts but are not needed permanently. Close any other in-
stances of OPEN MIND software that are not required.
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Other Check whether the operating system date is set correctly.
Temporary data on a computer can mount up. Check whether the
amount of temporary data can be reduced.
Reports when an anti-aliasing command is not available.
The multi-threading tessellation is disabled by an environment variable.
Check whether all the ‘Microsoft Visual C++ Redistributable Packages’,
which are required to operate the software, are installed correctly.

OpenGL version The graphics card does not support any version of the OpenGL pro-
gramming library that is required for OPEN MIND software. Use a driver
recommended by OPEN MIND or install the latest driver offered by the
manufacturer. Information is also provided on the OPEN MIND website
under Useful information.

OpenGL rendering context An OpenGL rendering context is a port via which all OpenGL com-
mands are directed. Each thread that makes calls for OpenGL must
have a current rendering context. Rendering contexts link OpenGL to
the Windows windowing systems.
Use a driver recommended by OPEN MIND or install the latest driver
offered by the manufacturer. Information is also provided on the OPEN
MIND website under Useful information. Check whether the graphics
card that is in use needs to be replaced by a graphics card recommen-
ded by OPEN MIND.

GPU memory Increase the memory on the graphics card or replace with another
graphics card that is recommended by OPEN MIND and has more GPU
memory.

Profile settings The use of NVIDIA GPU is recommended. Select as the preferred GPU
in the NVIDIA control panel or set using global default settings such as
‘Workstation App - Dynamic Streaming’ or ‘3D App - Visual Simulation’.
Or, switch off the ‘NVIDIA Optimus (TM) - technology’ in the BIOS setup
of the computer.

Display driver No display driver recommended by OPEN MIND is found for the graph-
ics card. Use a recommended driver or install the latest driver offered
by the manufacturer. Information is also provided on the OPEN MIND
website under Useful information.

Status to run hyperMILL® Change the requirements for running OPEN MIND software, which are
flagged as incorrect, so that they comply with the required conditions.

Overview of commands
The following commands are provided on the menu bar and toolbar:

File

Save as

Save the detailed system information and detailed test results as a *.txt text file or an
*.htm HTML file.

Send e-mail

Compose an e-mail with the detailed information that has been found and send to OPEN
MIND support at <support@openmind-tech.com>. An e-mail program is required for this
on the computer along with an Internet connection.

Print

Print a report with the detailed information that has been found.
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Exit

Exit the current application.

Edit

Copy

Copy the detailed information that has been found to the clipboard.

Help

About ...: Show the software version.
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Parallel installations
If several versions of hyperMILL are installed, it is possible to switch between versions using hyperMILL
Switch. To do this:

1. Run SwitchUi.exe  from the  C:\Program Files\OPEN MIND\Settings Wizard directory.

2. Select the required hyperMILL version, the CAD system and the language. Afterwards,
click Switch. Please close the software first!

Compatibility between versions

As an update not only fixes errors but also provides new functions, backward compati-
bility between the release version and an update or hotfix is no longer supported. This
applies from version 2020.1 and means that files saved with version 2023.1 Update 1,
for example, can no longer be opened with version 2023.
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4. Activating and managing products

Requesting licence data

Software copy protection
OPEN MIND software and CAD interfaces are copy-protected using Codemeter dongles from WIBU
Systems. For local licensing, each computer requires a separate dongle. It must be plugged into a USB
interface.

Activation code for licence
The licence management can be implemented independently of the production environment. The range
of licensed products per dongle can be tailored with the OPEN MIND Licence Manager according to your
requirements, for example, by porting 5X functionality to another editor or to the product extension. In such
a case, it is not necessary to replace the dongle.

A licence is the right to use OPEN MIND software such as hyperMILL® or components.

An activation code allows for one or several licences to be activated or deactivated on a dongle and is
not tied to any specific dongle. Activated products on a (randomly selected) dongle are always tied to their
activation codes. The activation code is supplied by e-mail.

The purpose of a return is to modify the scope of the OPEN MIND software in use on a dongle, for
example, when changing the software package from ‘Classic’ to ‘Expert’. The software package is returned
to the activation code and can then be adjusted by OPEN MIND.

The use of a licence server requires a network licence.

License Manager – Typical processes during activation
Overview of typical processes during the activation of products:

1. Initial situation: Separate activation on a computer connected to the Internet for hyperMILL®

Licensing process

 Computer with Internet

1. Install the Licence Manager

2. Attach dongle to USB

3. Start the Licence Manager

4. Select local dongle

5. Input activation code

6. Select and activate products

7. Close the Licence Manager

8. Remove the dongle
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 hyperMILL®computer

1. Install OPEN MIND software

2. Attach dongle to USB

3. Start OPEN MIND software

2. Initial situation: Network licensing on a hyperMILL® computer with a network licence, without
Internet access

Licensing process

 Computer with Internet

1. Install the Licence Manager

2. Attach dongle to USB

3. Start the Licence Manager

4. Select local dongle

5. Input activation code

6. Select and activate products with a network licence

7. Close the Licence Manager

8. Remove the dongle

 Licence server

1. Install the Licence Manager

2. Attach dongle to USB

3. Start the Licence Manager

4. Select local dongle

5. Turn on network server

6. Close the Licence Manager
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 hyperMILL®computer (client)

1. Install OPEN MIND software

2. Start the Licence Manager

3. Select the licence server

4. Turn on and use licence server

5. Close the Licence Manager

6. Start OPEN MIND software

Checking requirements
• Prior to the , please check the following points:

• Is there Internet access?

• Has the OPEN MIND Licence Manager been installed?

• Has a Codemeter dongle been supplied and plugged into a USB interface of the computer?

• Is there an activation code (5x5-digit string of characters)?

When the Licence Manager is installed, the dongle driver is installed automatically.

The activation and return of licences or OPEN MIND software products requires an
active Internet connection. After the activation, the dongle can be used without an
Internet connection.

Process
Start the OPEN MIND Licence Manager. The software can be found on the Start menu under OPEN
MIND. Finally, close the Licence Manager and start the OPEN MIND software.

The Licence Manager is installed in C:\Program Files\OPEN MIND\License
Manager and can be launched using LicenseManager.exe.

Search for and select dongle
The Licence Manager looks for all local dongles and all licence servers on the network. On the Dongle /
Licence server tab, all Available Dongles / Servers are displayed. Select a local dongle or licence server
(display of server name and dongle number).

The list shows all products allocated to the selected dongle or server with the following information.

Product name: Display of the products available on the dongle and/or licence server as well as, as a
branch view, the users of the products. Click on the product name to display the licensed users.

Expires: Expiry date - after this date, the product can no longer be used.

Maintenance: Expiry date - after this date, updates are no longer possible.
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Notes: Display of information on postprocessor and machine model licensing.

When a licence server is used, the following is additionally displayed:

Count: Display of number of products licensed

Used:: Display of the currently used number of product licences. If not all licences available are in use, the
display will be highlighted in green. If all licences available are in use, the display will be highlighted in red.

If the search does not yield any results, the message ‘No active licences found’ appears. In this case, plug
a dongle into the USB interface or set up a licence server.

If the message ‘No active licences found’ is displayed or if existing licences are to be managed, switch to
the Activation code tab:

Select activation codes
Already existing activation codes are validated automatically and displayed for selection under Available
activation codes in the Activation code tab. Use Add activation codeto add a new activation code.

The complete activation code can be copied to the fields in one process via the clip-
board. For this purpose, place the cursor in the first field.

Keep your activation codes in a safe place. The codes will also be required to return
products, for example, as part of software maintenance.

Please do not interrupt the activation process as this could damage the dongle.

Once the fields have been filled in, a connection to OPEN MIND is established automatically and the
activation code is checked.

 Activation code is recognised.

 Error, activation code could not be recognised. Check that it has been entered correctly and that you
are connected to the Internet. Also check the firewall settings and contact your network administrator if
necessary. Click OK to confirm the successful operation.

Select the required activation code under Available activation codes:

 Remove an entry from the activation codes.

 Bookmark an activation code as a favourite that is always displayed at the top.

 Reload the activation codes.

On the Activation code dialogue page under Targets, choose the dongle, whose scope of licensing needs
to be changed.

The list displays all allocated products and test licences with status (Not activated) or the dongles activated
through them.

Activate or return
Select the required products from the list and click Activate licence and/or Return licence.

- Ensure that the relevant dongle is available locally.

- Ensure that the software has been closed before you use Return.
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Activate licence allocates the product to the selected local dongle.

Return licence deactivates the product on the selected dongle and returns it to the activation code.

If products are to be returned to OPEN MIND, for example, when changing from local licensing to network
licensing, proceed as follows:

1. On the Activation code tab, select the activation code from Available activation codes.

2. The List displays only the products that must be returned.

3. Click Return licence.

While products still need to be returned to OPEN MIND, the further management of
products belonging to the activation code is blocked.

This requires an active Internet connection! A connection to OPEN MIND is established automatically and
the changes are implemented.

 Change successful

 Error, change not possible. Check whether an Internet connection is established. Switch to the Dongle /
Licence server tab and

 reload by clicking on the Activation codes button.

If the error persists, please contact your Support.

Select the required activation code under Available activation codes.

 Removes an entry from the activation codes.

 Bookmarks an activation code as a favourite that is always displayed at the top.

 Reloads the activation codes.

Under Targets, select the dongle, whose scope of licensing needs to be changed.

A dongle for a licence server can be managed locally using any OPEN MIND Licence
Manager. For this purpose, plug the dongle into the local USB interface.

Network licence and licence server
On the Options tab, select the Use this computer as a licence server option if the computer is to be used
as a licence server on the local network.

To select this option, you must have administrator rights.

Use the Use licences from a server option if you want to access a network licence. An available licence
server is accessed automatically via Locate licence server automatically. Enter a server with its IP address
or name manually in Server name if the Use a specific licence server option is to be used.

To configure these settings, you must have administrator rights.
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You must start the Licence Manager with administrator rights, for example, using the
Windows Run as administrator function. For this purpose, select LicenseManager.exe in
the program directory and right-click to open the Windows shortcut menu.

If you are working with network licences, specify a product that is to be started regularly on the computer
on the Start tab under Select base product. Otherwise, where available and permitted, the local dongle will
be evaluated or the most extensive product package available on the network will be started ( Automatic
selection).

You can use Additional client info to store a note (for example, phone number and e-mail address) that is
displayed for every user when a licence server is used.

Reload on the Dongle/Licence server tab starts a new search for available dongles and licence servers.
Group list by users sorts the list of products in such a way that the products currently in use are shown as
being allocated to the users. The status bar displays information on the settings of the local computer.

Proxy authentication

If you use an Internet proxy with authentication in your company, on the Options tab you must enter the
User name and Password for the proxy in order to activate the licences.

Afterwards, you can log in using the Logon to proxy button. On successful login, the user name and
password are locked for editing and the Activation code tab of the Licence Manager is unlocked.

When an Internet proxy with authentication is used, the activation codes are not stored on the system and
are also not loaded when the Licence Manager is started. They must be entered separately each time a
licence is changed.

Specify warning period
On the Options tab, you can use the Warning period option to specify how many days in advance you wish
to be notified of licences that are going to expire. By default, you will receive a warning 14 days before a
licence expires.

To change this setting, you must have administrator rights.

Specify start options
Here, you can configure the standard start behaviour of hyperCAD-S / hyperMILL.

If you do not make a selection, hyperCAD-S / hyperMILL will always start with the maximum available
scope of licensing and provide the maximum available product functionality.

For example, if you want to restrict the use of licences in a network environment, you can select the base
products and options here that are used on start-up.

If you choose an option, for which you do not have a licence, this option will not be
loaded on start-up.

An error message, indicating that this option is not available, will also not appear.
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5. Administrator manual

Introduction
This manual details the unattended installation and administrative tasks in relation to hyperMILL® and
hyperCAD®-S. Installation with the user interface is described in the installation guide.

Silent installation of hyperMILL® / hyperCAD®-S
Unattended installation can be performed using two methods. It can either be implemented with the
setup.exe or with the individual MSI packages. We recommend using the setup.exe.

In both cases, the product must be configured following installation. The product cannot be started follow-
ing installation without firstly being configured.

Prior to installing hyperMILL®, any CAD systems, into which hyperMILL® should be integrated, are to be
installed.

There is no unattended installation for thehyperMILL licence server. This must be installed manually.

Installation with setup.exe

Property Value Description

INSTALLDIR Path The target path of the installation. The default
value is <Programs>\OPEN MIND. Subfolders
are created automatically.

IS_CAMOB-
SERVER

0..1 Default: 0. A parameter controlling recognition
of the SHOP Viewer. This can be set for initial
installation.

/language:LCID LCID:

1028; 1029; 1031; 1033;
1034; 1036; 1040; 1041;
1042; 1043; 1045; 1046;
1049; 1055; 1060; 2052

Sets a system language for the installation proc-
ess. Determines the language of the installed
help. Additional auxiliary languages must be in-
stalled separately.

LCID ISO HMLANG

1028 CN_TW chinese_trad

1029 CZ czech

1031 DE german

1033 EN english

1034 ES spanish

1036 FR french
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LCID ISO HMLANG

1040 IT italian

1041 JA japanese

1042 KO korean

1043 NL dutch

1045 PL polish

1046 PT portuguese

1049 RU russian

1055 TR turkish

1060 SL slovenian

2052 CN_ZH chinese

Example:

setup /silent INSTALLDIR=”c:\open mind\cam” /language:1031

Installs the license manager and hyperMILL® in German in the folder c:\open mind\cam without user
interaction.

Further command line options for the setup.exe can be found online at:

https://helpnet.flexerasoftware.com/installshield25helplib/helplibrary/SteSetupexeParam.htm

Installation without setup.exe
In the case of installation without the setup.exe, the system components must be provided manually. hy-
perMILL® and hyperCAD®-S use the following system components.

System compo-
nent

Version Licence Manag-
er

hyperMILL® hyperCAD®-S

VC-Redist 2013
Update 1 x86

12.0.21005.1 x

VC-Redist 2013
Update 1 x64

12.0.21005.1 x

VC-Redist 2019
x64

14.29.30038.00 x x

Microsoft .NET
Framework 4.8

x x x
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System compo-
nent

Version Licence Manag-
er

hyperMILL® hyperCAD®-S

CodeMeterRun-
time

7.40.5001.502 x x x

HeidenhainDNC
x64

1.7.2 x x

The product is installed following installation of the system components.

• Licence Manager

• hyperCAD®-S

• Language pack for hyperCAD®-S

• hyperMILL®

• Language pack for hyperMILL®

The MSI packages support their own properties here.

Property Value Description

INSTALLDIR Path The target path of the installation. The default
value is <Programs>\OPEN MIND. Subfolders
are created automatically.

HMLANG Language English, German, French, …. Sets the product
language. The product starts in this language
following installation.

SUITE_UI 0..1 Indicates whether automatic product configura-
tion should be started. The default value for this
property is 0, whereby automatic configuration is
not started. Automatic configuration is guided by
a user interface and should not be called in an
unattended installation.

TRANSFORMS LCID.mst

Example:

TRANSFORMS=1033.mst

Transformations (*.mst files) are available
for hyperMILL® and Licence Manager, which
provide language-specific text for start menu en-
tries. The product is offered in these languages.

LCID ISO HMLANG

1028 CN_TW chinese_trad

1029 CZ czech

1031 DE german
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LCID ISO HMLANG

1033 EN english

1034 ES spanish

1036 FR french

1040 IT italian

1041 JA japanese

1042 KO korean

1043 NL dutch

1045 PL polish

1046 PT portuguese

1049 RU russian

1055 TR turkish

1060 SL slovenian

2052 CN_ZH chinese

The configuration must be performed once installation is complete.

Configuration
For the configuration of hyperMILL® and hyperCAD®-S, the SettingsService is provided. The Settings-
Service is able to transmit the typical configurations from one system to the next. In special cases, manual
intervention is required.

The SettingsService
The configuration of the product can be largely automated by means of the SettingsService. For this pur-
pose, the SettingsService recognises a series of command line options with which the required operations
are started.

SettingsService.exe [-allswitch|-cadswitch|-import] [<version>|-disable]
[-disable|-update] [-defaultdb] [filepath]

-allswitch Activates/deactivates hyperMILL
in all found and supported CAD
platforms.

The version number of the version to
be activated is required or -disable.
(Specialisations: -tdswitch, -swswitch, -in-
vswitch, -hcswitch available for thinkde-
sign, SOLIDWORKS, Autodesk® Inventor®,
hyperCAD®-S)
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-cadswitch Activates the COM interfaces of
the hyperCAD®-S specified un-
der <version>.

-import Imports the settings from the
specified .omsettings file and ac-
tivates hyperMILL in all found,
supported CAD platforms.

Only .omsettings files exported with the
SettingsWizard of the same version are
supported.

-init Configures hyperMILL with the
default settings and activates it
in all supported CAD platforms.

Example

Initialises the system for the use of hyperMILL® xx.x in all supported CAD platforms and makes the
standard databases for tools and macros plus the standard colour tables available.

hyperMILL® product version xx.x (internal version)

2022.1 29.0

2022.2 30.0

2023 31.0

2023 Update X 32.0

SettingsService.exe -allswitch xx.x -defaultdb

Example

Removes all hyperMILL® versions from all supported CAD platforms

SettingsService.exe -allswitch -disable

Example

Removes hyperMILL® xx.x from the supported thinkdesign installations.

SettingsService.exe -tdswitch xx.x -disable

Example

Registers the thumbnail display in Windows Explorer via hyperCAD®-S xx.x.

SettingsService.exe -cadswitch xx.x

Example

Imports the settings from the specified .omsettings file and activates hyperMILL in all supported CAD
platforms.

SettingsService.exe -import 
"C:\Users\MyUsername\Documents\MyDocuments\mySettings.omSettings"

Registry
There are registry keys that affect the behaviour of hyperMILL® during installation or the first application
start.
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Registry keys

• HKEY_LOCAL_MACHINE\SOFTWARE\OPEN MIND

• common\Configuration\

• GlobalWorkingSpace (REG_SZ) refers to the global working space.

• ProjectDirectories (REG_SZ) refers to the project directories.

• OMConfig (REG_SZ) refers to the CFG files that are required for licensing.

• Language (REG_SZ) defines the default language of hyperMILL®.

• TemplateToolDB (REG_SZ) refers to the tool database that is loaded if the docu-
ment and application databases failed to load (emergency database).

• common\<Product Version>\Languages

• Contains the lists of languages that you can select for hyperMILL®.

All further registry keys are user-specific and cannot be used during the installation.

Security settings
hyperMILL® was developed to allow users to work with power user rights. If it becomes necessary to
run hyperMILL® with limited rights, some security settings will have to be adjusted.

Important information about license mode
To ensure that all unused network licences are available, they are automatically released after two hours
of software inactivity. Please make sure that your data is backed up automatically (hyperCAD®-S, File →
Options → Options/Properties → Program).

The time for automatic release of a license can be set as follows:

The LicenseCleanupTime can be controlled on the server by the registry value:

HKEY_LOCAL_MACHINE\SOFTWARE\WIBU-SYSTEMS\CodeMeter\Server\CurrentVersion\Clea-
nUpTimeOut

in which the time in minutes is entered after an inactive license is automatically released. The default value
is 120 minutes.

The time cannot be reduced below 60 minutes.

If the value is changed, the CodeMeter service must be restarted on the server. Restart-
ing the service terminates all current licence sessions and ends all current sessions of
the product
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6. Hardware / software requirements

OPEN MIND Technologies AG (01.03.2022)
The installation checks automatically whether a 64-bit program version of the software products can be
installed and whether all requirements for the respective variant on your computer have been met. If
necessary, any missing but necessary components or programs will be installed automatically.

If Microsoft .NET Framework is installed, your system may have to be restarted after-
wards.

hyperMILL® for hy-
perCAD®-S

hyperMILL® for Au-
todesk® Inventor® (1)

hyperMILL® for
SOLIDWORKS

Computer equipment

USB connection (min. 2.0) x x x

Processor (at least) 4 Cores

> 2.2 GHz

4 Cores

> 2.2 GHz

4 Cores

> 2.2 GHz

Processor (recommended) 8 Cores

> 4 GHz

8 Cores

> 4 GHz

8 Cores

> 4 GHz

RAM memory GB (at least) 16 16 16

RAM memory GB (recom-
mended)

32 32 32

Free disk space (GB) (2)

CAD/CAM product

10 10 10

OpenGL-compatible
graphics card (3)

x x x

Possible operating systems

Windows 10

Windows 11

x

x

x

x

x

x

(1) Component of Autodesk Inventor Series.

(2) Recommended memory for use of the respective product; with increasing complexity of the machined
model, more memory is required.
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(3) Suitable graphics card for CAD/CAM workstation. Recommendation: NVIDIA Quadro with at least 2
GB,

The recommendations of the respective CAD manufacturer apply for hyperMILL® for Autodesk® Inventor®

and hyperMILL® for SOLIDWORKS.

For hyperMILL® in hyperCAD®-S the following applies: correct functioning when using AMD ATI-graphic
cards cannot be guaranteed.

A graphics card with an OpenGL-accelerated graphics card driver from OpenGL version 4 is recommen-
ded for hyperCAD®-S. Please refer to the overview of graphics cards and graphics card drivers recommen-
ded for use with hyperCAD®-S on the OPEN MIND website.

The hardware listed there has been automatically tested for use and is being used in
day-to-day work.  This does not mean that  hyperCAD®-S can be run only with the
hardware recommended. hyperCAD®-S should run on any graphic platform with a full
implementation of OpenGL.

Windows does not support any OpenGL-accelerated drivers. As a user, you must install a manufacturer's
or OEM driver for the direct use of hardware-accelerated OpenGL. These drivers are available from the
websites of most graphic hardware manufacturers.
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7. Trademarks

hyperMILL® and hyperCAD® are registered trademarks of OPEN MIND Technologies AG.

Verification and simulation technology from hyperVIEW provided by MachineWorks Ltd.

Autodesk® Inventor® and the Autodesk logo are registered trademarks of Autodesk Inc.

CATIA and SOLIDWORKS are registered trademarks of Dassault Systems SA.

Windows and Windows products are registered trademarks of Microsoft Corporation.

All other brand and product names are registered trademarks of their respective owners.
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